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�FAXmaker - an overview

Introduction

Congratulations with purchasing FAXmaker. FAXmaker for Exchange will save your company time and money by offering you advanced network fax technology. With FAXmaker, sending a fax is as easy as printing a document. 

FAXmaker for Exchange is designed to integrate seamlessly with MS Exchange server. Therefore this manual assumes a working knowledge of Microsoft Exchange server, and that you have Exchange server up and running.

The FAXmaker system

The FAXmaker system consists of a Fax server program running as a gateway or “Connector” on the computer running Exchange server, and the client software, running on the users’ workstations. The client software consists only of a fax printer driver and a viewer, which enables all Exchange users to send a fax by printing to the FAXmaker driver.

The system is depicted in the following figure;

� EINBETTEN Visio.Drawing.3  ���

Figure 1 FAXmaker fax gateway� XE "fax gateway" � running on MS Exchange server.

Figure 1 shows the FAXmaker fax server/gateway running on the Exchange server machine. Because FAXmaker was designed to run on Windows NT,� XE "Windows NT" � it does not require a separate machine. Rather it will run in the back ground on the same machine as MS Exchange server.

�Installation

Introduction

This chapter describes the installation of the FAXmaker software onto the Exchange server. It will help you choose the installation options available, but will not discuss the user’s configuration options, which are explained in the following chapter.

Prior to running the installation procedure, you are advised to read the chapter “FAXmaker - an overview”.

Running the installation procedure

1. Insert disk 1 of the FAXmaker for Exchange disk set in your diskette drive. Remember that you must run the installation program from the computer running Exchange server.

2. Run 'setup.exe' from the File Manager or choose 'Run' from the 'File' menu in Program Manager and type in <a:\setup.exe>.

3. The set-up procedure will now start, and you will be prompted by the installation routine whether you want to continue set-up. Click on the 'Continue' button.

�

User information

4. Setup will now prompt you for your company name, fax number and registration number. The registration number is located on the disk envelope. If you are evaluating the product, do not enter a registration number.

5. The setup will now query the name of the server computer. Please confirm it.

�

Exchange Organisation name

6. The setup program will now query the organisation name. The organisation name is stored in MS Exchange Server, and should not be changed unless you have multiple organisations installed in MS Exchange server. Click OK to continue.

�

Account name for services

7. Setup will now prompt you for an administrator� XE "administrator" � account to run the service. You should enter the name and password� XE "Password" � of a valid NT account with administrator rights.

8. Setup will now prompt you for a directory name and service name. There is no need to change the service and directory name, however in certain cases in which you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names. 

Note; To de-install a service, you must delete all references to it from the registry and re-boot. Click OK to continue.

�

Setup prompts for Exchange directory and service name

9. Setup will now ask you where you want the FAXmaker fax server files to be installed. FAXmaker will need approx. 5 megabytes of free hard disc space.� XE "disc space" � In addition to this you must reserve approximately 10 Mbytes for temporary fax files.

10. Setup will now prompt you where to copy the client setup programs. The client setup program installs the fax printer driver and fax viewer on the user’s PC. The location where you copy the client setup programs should be accessible to all users.

11. The setup program will now copy all program files.

12. FAXmaker setup will now prompt you for a FAX service name. There is no need to change the service  name, however in certain cases in which you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names.

Note: To de-install a service, you must delete all references to it from the registry and re-boot. Click OK to continue.

�

Setup prompts for a fax server service name

After the software has been installed, the setup program will continue to install a program group for FAXmaker. The program group includes a fax server setup program, which is also listed in the control panel. Before starting the fax server service, please setup the fax server using this program. For more information regarding setting up the fax server, please refer to the chapter on fax server setup. 

�

The FAXmaker for Exchange program group

After installing FAXmaker for Exchange, you must start the Exchange administrator� XE "Exchange administrator" \r "D2HBExchange_adm6" � and configure the users. This is explained in detail in the next chapter - User setup.

� XE "OCR routing" �Installation of the OCR routing module



THIS SECTION IS ONLY APPLICABLE TO FAXMAKER USERS WHO HAVE PURCHASED THE OCR MODULE.

FAXmaker users can opt to purchase an OCR module, that can automatically route� XE "Route" � incoming faxes to the right recipient. With this module, the fax server will scan the incoming fax for a recipient name, and if it finds a recipient's name, FAXmaker will automatically route that fax to the recipient's mailbox.� XE "Mailbox" �

The module includes 1 OCR support disk, as well as a revised serial number. 

To install the module, run a:\setup.exe from the file run command in the Program manager menu. 

Follow the instructions explained during the installation. 

You will now be able to setup OCR routing per user from the Exchange administrator,� XE "administrator" � by going to the “OCR tab” in the routing setup.



�User setup

Introduction

The setup of the FAXmaker users is done from the Exchange Administrator.� XE "Exchange administrator" \r "D2HBExchange_adm9" �� XE "administrator" \r "D2HBadministrato9" � The person who is authorised to supervise the system can add or delete FAXmaker users and administer their settings. 

�

The Exchange administrator

After FAXmaker has been installed, a number of new objects have been added to the Exchange administrator;

1. Add ins\FAXmaker gateway extension - this object allows you to setup permissions for the FAXmaker gateway. This is an MS Exchange feature, so please check the Exchange documentation for more information on how to do this.

2. Addressing\Email address generators\FAXmaker email address generator. This object allows you to change the name. There is no need to change this.

3. Connections\FAXmaker directory. This is the main FAXmaker object which contains user setup.

Registration

Before you setup the users, enter your serial number in the options tab. This serial number will also allow you to upgrade to more users or add additional modules. To read more about the upgrade options of FAXmaker, please visit our web site at http://www.gfifax.com.

To enter the serial number;

1. double-click ‘connections’. In the right pain, the FAXmaker directory is listed. (The exact name may differ, because you specify it during installation.) 

2. Double-click on the FAXmaker directory.

The FAXmaker directory property dialog appears. Go to the options tab. enter the registration number at the top of the dialog. Click OK to continue.

Note; If you are evaluating FAXmaker for Exchange, leave this field empty and test FAXmaker with 2 Exchange users maximum. (This is done by disabling Exchange users as FAXmaker users.)

User settings

To setup up the FAXmaker users from the Exchange administrator;

1. double-click ‘connections’. In the right pain, the FAXmaker directory is listed. (The exact name may differ, because you specify it during installation.) 

2. Double-click on the FAXmaker directory.

The FAXmaker directory properties dialog appears. This dialog has 4 tabs; General, Address Space, Options, Users

To setup users, go to the users tab. To setup a user, highlight his/her name with the mouse and select the appropriate settings;

�

The user setup dialog in the FAXmaker connector

General Options

FAXmaker user - This option will effectively enable or disable the user as a FAXmaker user. If you have more Exchange users than the number of FAXmaker users licensed, you must disable users.

Permission to configure settings remotely - This option will allow the user to change coverpage, faxheader and send resolution by sending mail to the faxadmin. (See the chapter on Remote administration for more information)

Send Options

Normal resolution/High resolution - Select the default resolution to send faxes in. This option can be overridden by specifying a different resolution in the body of the message. (See fax options� XE "FAX options" � in the “Sending faxes” chapter).

Personal FAX header� XE "FAX header" � - activating this option will include the sender’s name on top of the FAX. This will allow recipients of the FAX to identify the sender. 

Receive Options

Receive incoming faxes - This option specifies that this user must receive incoming faxes, so that she/he can route� XE "Route" \r "D2HBRoute11" � faxes to the right users.

Include/Exclude routed faxes - This option allows you to specify whether to include or exclude faxes  for which a recipient already has been found using available routing methods.

Routing

Routing refers to the ability of FAXmaker to automatically route an incoming fax to the right person. There are a number of ways through which this can be achieved.

Per user you can setup one or more forms of routing. For example you can specify CSID� XE "CSID" � and OCR routing.� XE "OCR routing" � 

CSID routing - this method relies on the FAX ID� XE "Fax ID" � which each FAX machine/FAX card displays when sending a FAX. Since it rarely changes, it can be used to identify the sender and thus the corresponding recipient. 

�

Routing a fax using the FAX ID (CSID)

You can setup CSID routing from the CSID tab in the routing dialog. A list box will appear where you can add, delete or edit CSID numbers for this user. The numbers will be stored in the CSID database.

Automatic Updating

The CSID database can be automatically updated by each CSID that a user sends a fax to. This technique relies on the fact that if a user sends a fax to a particular fax machine, he is likely to be the recipient of the answer to the fax. If you enable this option, each time the user sends a fax, the CSID of the receiving fax is stored in the user’s CSID database.

DTMF routing - DTMF (Dual Tone Multi Frequency) tones are the tones generated by a telephone handset, and can be used to identify a recipient. The DTMF number can be appended after the regular fax number. The system works in the following way; The caller dials the fax number and waits until the call is answered. The fax card will now transmit a tone, after which the caller must enter the DTMF routing number. The FAXmaker server will recognise the DTMF number and use it to identify the recipient of the fax.

DTMF routing can work well, if you explain your callers how to use it. This can be done on the FAX cover of outgoing faxes. DTMF routing can also be used behind a PBX which supports DID. In this case you can use excess DID lines from the PBX to route the FAX to an extension.

�

Routing a fax using DTMF/DID routing

DID routing (Direct Inward Dial) - DID routing is generally considered the most reliable form of automatic inbound� XE "Inbound" �� XE "Inbound router dialog" � routing, because it relies on information provided by the telephone exchange, not on information provided by the caller. The system is completely transparent to the caller and does not require any effort on his part. DID can be used in conjunction with a PBX or hardware that recognises DID signals. 

To setup both DID and DTMF routing, go the DID/DTMF� XE "DID/DTMF" � tab in the routing dialog. Fill in an appropriate routing code for the user. Remember that actual activation of DID or DTMF routing is done in the FAX server. The administrator� XE "administrator" � only stores the users’ routing code. The same routing  code can be used for both DID or DTMF routing.

�

The OCR routing setup dialog

OCR routing - Another easy way to route faxes automatically is using OCR. This system will OCR the first page of a fax, and consequently search the fax for a recipient name. If it finds one, it will route it to the recipients mailbox.� XE "Mailbox" � This option requires the optional OCR module.

�

Routing a fax using OCR

OCR routing requires the purchase of an additional module, the OCR engine. If you have not purchased the OCR module, you can configure it, but not activate it.

To setup OCR routing, click the OCR setup button in the Routing tab. This dialog has two tabs ;

1.  Greeting - meaning that the FAX server will search for a greeting such as Dear, Mr etc., before the actual user name. This means that the FAX server will only attempt to recognise a user name after it has recognised a  greeting word. You can add and remove greetings by clicking the add and remove buttons. You can enter a matching ratio, or confidence level in the edit box. This allows you to specify the confidence FAXmaker must have before it will actually recognise it as a greeting. Using this option you can tune the system to your specific needs. For normal use, a low setting is required, since greetings are short, and a lower matching ratio allows for OCR mistakes, and for 'spelling mistakes'.

2.  User keywords� XE "keywords" � - here you can enter keywords per user, which FAXmaker will search for to identify the recipient of a FAX. If, for example, an individual Mr. Johnson, is also known as John, this keyword may be entered also, as well as Mr. Johnson. In addition, if Mr. Johnson is responsible for international sales, one might add international sales as a keyword too. A matching ratio can be entered to tune the system. 

Call blocking

Call blocking allows you to exercise control over the fax numbers that the users can send to. To enable this option, activate the radio box. You can now add numbers to the list which may not be dialled by the user. FAXmaker will check the list before each fax transmission, and not send any faxes starting with numbers listed in the call blocking list. This means that if you want to disallow certain users making international fax transmissions, you only need to insert the international dial out number (for example 00, 09 or 011). Alternatively you can block specific fax-numbers. 

Coverpages & Templates

Each user can store a number of coverpages and templates to be used for sending faxes.



�

The Coverpage and Template setup dialog

Difference between a coverpage and a template

A coverpage is inserted in front of each fax, and a template is used to format text from an email message onto a template. This means that by designing a template with a letter head and fields, you could eliminate the use of a coverpage.

Whether you use a template or coverpage or both is up to you to decide.

Each user can have multiple coverpages & templates, of which one can be set as default. To override the default cover or template, the name of the coverpage or template must be specified in the body of the email message, as follows;

::C=cover1, T=template

For more information about specifying fax options,� XE "FAX options" � see the fax options section in the “Sending faxes” chapter.

To send a coverpage with each fax, you must setup a coverpage for each user and set it default first.

For a description how to design a coverpage, please refer to the chapter on coverpages & templates.



�The Fax Server Program

Introduction

The Fax Server program is the core of FAXmaker. It is fully multitasking and will handle sending and receiving of faxes simultaneously. The Fax Server application runs as a service in the background. Setup of the server is performed from the FAXmaker configuration applet.

�

The fax server configuration� XE "Server configuration" � applet

Configuring the Fax Server

Before you start the Fax Server service, you must configure the 'Ports' that you will be using in the Fax server. A port� XE "port" \r "D2HBport17" � is a COM port with a modem attached or a fax line on a fax board. To configure a port;

1.  Start up the Fax server applet.

2.  Select Add.

3.  Choose the appropriate Port (s).

4.  Now you can specify the settings of the port by clicking on properties.

5. A tabbed dialog will appear, which allows you to specify modem, fax, printing & routing options for that port.

�

The modem setup tab

Modem Setup

This tab allows you to configure your modem. 

Modem control

Modem type - Select your modem from the drop down list box.

Initialisation string - Although the initialisation string does usually not need to be changed, you can edit the string in this field.

Line options

Tone dialling - Activate this check box if you can use tone dialling. If you deactivate it, the Fax server will use pulse dialling. 

Wait for dial tone - If you activate this option, the fax server will only send the fax if the modem detects a dial tone. Some export� XE "Export" � modems do not recognise the dial tone, so you must first test whether your modem recognises a dial tone.

Check for busy tone - Activate this option if you want the modem to check for a busy tone.

Speaker mode - Select whether you want the speaker to be 'Always Off', or 'On until connected' or 'Always On'.

Speaker volume - Select the appropriate volume. 

�

The fax setup tab

Fax Setup

General options

Maximum Speed - Select the send & receive speed according to your modem's capabilities. Remember that not all modems are able to negotiate “down” well, so choose 9600 if in doubt.

Local ID- Enter the fax ID� XE "Fax ID" � which you wish to appear above each fax.

Send options

Send outgoing faxes - This radio box allows you to determine whether this port/modem should send faxes.

Dial prefix - If your lines are located behind a PBX, you can specify a dial prefix here.

Number of retries - Sets the number of times FAXmaker will try to send a fax.

Retry delay - This option allows you to set a delay between retries in seconds.

Fax header� XE "FAX header" � - The fax header is a word or company name which will appear on top of each fax.

Receive options: 

Answer incoming calls - To have the fax server receive faxes, activate this check box. Specify after how many rings you want FAXmaker to answer in the 'Rings until answer field'.

Incoming call detection� XE "Incoming call detection" � - By default the fax server will answer all incoming calls as fax only. However, if you have installed the voice mail� XE "voice mail" � or fax on demand� XE "fax on demand" � module (optional module), you can have the fax server detect between fax/voice or voice only calls. 

�

The routing setup tab

Routing

Inbound� XE "Inbound" �� XE "Inbound router dialog" � routing of faxes is set up in the Administrator,� XE "administrator" � however you must activate the various routing systems in the server in the routing dialog. Activate a routing method by clicking on the appropriate radio box.

DTMF options

Generate beep - you can have the Fax server generate a beep when it picks up  the line. This will alert the caller or PBX to enter the DTMF string.

Number of digits - Length of DTMF string/number that caller or PBX must generate.

�

Autoprint setup tab

Autoprint

The printing options dialog allows you to configure automatic printing per port.� XE "port" \r "D2HBport21" � That is, you can select either the same or different printers to service the printing requests from various ports. Both incoming and outgoing faxes can be printed automatically. Printing of outgoing faxes is configured in the general setup because it is not port specific.

Note: Because a fax is an image, printing a fax can take some time. The auto-print feature requires a faster PC, and printing must be set to low priority in the print manager if the printer is connected to the fax server directly. .

RTF converter setup

The RTF converter converts E-Mail messages to fax. The converter options are changed from the FAX server configuration� XE "Server configuration" � applet. 

To change RTF conversion options;

1. Click the RTF setup button at the bottom of the list of ports.

2. A dialog appears which allows you to specify default page size & margins. These settings are important when designing your template & cover page.� XE "cover page" �

Gray scaling

If your coverpages or templates include images which you would like to have scaled to Gray (i.e. not using only black or white), you must enable this option. Gray scaling requires a 16 colour VGA graphic mode and  slows down the performance of the RTF conversion by about 5 seconds per page.

Scaling

FAXmaker's cover pages are created from RTF files (32 bit server only), using a feature of windows which can contain a bug. This results in text being clipped during conversion. You can solve this bug by following the steps outlined below, or you can switch on scaling in the general setup dialog of the server.

However it is preferable to follow the steps below, because if you do *NOT* use scaling you get a better quality and performance.

To solve the problem if your fax server runs on Windows NT� XE "Windows NT" � 3.51;

Install service pack 4, available from Microsoft's web site. 

When running on Windows NT 4, there should be no problems.

General setup

The general setup contains general options which are not specific to a port. To change general options;

1. Click the general button at the bottom of the list of ports.

2.  A dialog appears which allows you to specify general options;

Autoprint

Outgoing faxes can be automatically printed on a network printer by enabling this option from the radio box. 

� XE "Monitor" �The FAX Server Monitor

The Fax server monitor allows you to monitor the status of the fax service. The top pane shows the activity on each of the ports, and the bottom pain shows you a detailed error log.

�

The Fax server monitor

The Fax server monitor can be started from another PC as well, however the error log will not be listed.

�Installing the Client software

Introduction 

After installing the fax server program on the Exchange server, you can already send faxes by typing the message in the Exchange client. However if you wish to send faxes directly from your Windows applications, or wish to view your incoming faxes using the FAXmaker viewer, users must run a setup program from the user’s machine first.

The setup program installs the printer driver and the viewer on the user’s machine.

Installing Windows 3.1 or 3.11 clients

1.  Run <setup.exe> located in the install\win 3.1 directory located under the install directory, by using the 'Run' command from the 'File' menu in Program Manager. The exact location of the client setup programs was determined during initial FAXmaker setup.

2.  Follow the installation instructions displayed in the installation dialogs.

3. Reboot your machine after completing the installation.

Installing Windows 95 clients

1.  Run <setup.exe> located in install\win95 directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs.

3. Reboot your machine after completing the installation.

� XE "Windows NT" \r "D2HBWindows_NT23" �Installing Windows NT clients

1.  Run <setup.exe> located in the \install\winNT directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs.

3. Reboot your machine after completing the installation. 

4. After rebooting, continue to install the FAXmaker printer driver as described below.

Installing the Windows NT fax printer driver.



After running the FAXmaker Windows NT Install program, you must install the fax printer driver from the Print Manager. 

To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print Operators, or Power Users group. 

Installing the printer driver and creating the printer

Use the Print Manager ‘Create Printer’ option from the Printer menu. 

1. Start the Print Manager from the Control Panel or Main group.

2. From the Printer menu, choose ‘Create Printer’.

3. In the Printer Name box, type <FAXmaker>.

�

The Windows NT create  printer dialog

4. Install the FAXmaker printer driver; In the Printer Properties dialog box, select ‘Other’ in the Driver box. 

5. In the Install Driver dialog box, specify the drive and path where the install\winnt directory is located, for example;

d:\apps\install\winnt35 and choose the OK button. 

6. In the Select Driver dialog box, select the FAXmaker driver. Then choose the OK button. 

7. The driver will now be installed by FAXmaker. 

8. In the Driver box, select the FAXmaker printer driver ‘FAXmaker’. 

9. In the Print To box, Select the ‘GFIFAX’. (This port� XE "port" � should have been automatically added after you rebooted the system. 

10. In the Create Printer� XE "Create Printer" � dialog box, choose the OK button. 

11. This completes a basic printer installation. Once a driver is installed, Print Manager automatically displays a dialog box allowing you to set up the features of your printer. There is no need to change any of these options. 

12. Remember that under NT the client must be active before printing to the FAXmaker printer driver. Otherwise the send fax windows will not pop-up automatically.

Note; Since Windows NT 4 was not released yet when FAXmaker for Exchange was released. Therefore you need to check the GFI web site for the latest Windows NT 4 printer drivers.

�Advanced Use

Introduction

The chapter on advanced use is meant for users of FAXmaker who wish to tune their FAXmaker installation and get to know all its features.

Fax server error messages

The following is a listing of fax server error codes and the corresponding error causes.

1200: MServer failed to launch fconvert.exe

1201: MServer failed to concatenate voice files

1202: Mserver-line wants to call vpEntryPoint in WAITRING but vprog32.dll is not loaded.  To avoid this, don't do voice-detection

1203: Attempt is made to initialise vprogres (already loaded), but: fod-ini doesn't exist or prompts directory specified in fod.ini doesn't exist.

1204: vpEntryPoint fails. Something wrong with vprogres.

1205: Database entry not found in [Directories] section of mserver.ini file.

1206  Wrong language specification in [Misc] section's 'Language' field in MSERVER.INI file";

1207  Error loading language dll.

1208  'Program' entry not found in [Directories] section of MSERVER.INI file. Program quits

1209  'Database' entry not found in [Directories] section of MSERVER.INI file. Program quits

1210  'Mailbox'� XE "Mailbox" � entry not found in [Directories] section of MSERVER.INI file. Program quits.

1211  'SMailbox' entry not found in [Directories] section of MSERVER.INI file. Program quits

1212  'Prompts' entry not found in [Directories] section of MSERVER.INI file. Program quits

1213  Unable to convert coverpage because the tpt-file does not exist or couldn't be opened

1214  Unable to convert coverpage because the tpt-file couldn't be read although it exists

1215  Unable to convert coverpage because rtf=>fax conversion� XE "Fax conversion" � failed

1216  Unable to convert coverpage rtffax32.dll was not found or else binding of function to this dll failed

1300: FAXMAKER.FON missing in windows-directory. Tiffile is NOT able to create a fax-header

Internet site http://www.gfifax.com  

More information regarding technical support and tips for using FAXmaker can be found on our web site;

http://www.gfifax.com.

The web site will always have the most up to date listing of tips and support questions.



�CoverPages & Templates

Introduction

Coverpages and templates (similar to cover pages but used for outgoing emails), can be used by all FAXmaker users. You can design your cover page� XE "cover page" \r "D2HBcover_page29" � or template to include your company logo, sender and recipient fields, message fields and any bitmap images. You could also use or customise the existing templates included in FAXmaker.

Designing a coverpage/template

FAXmaker uses a standard rich text format file as a template to create cover pages. 

The rich text format (RTF) is a standard amongst word processors and is supported by virtually any word processor, including MS Word, Amipro and Wordpad (included in Windows 95). This means that you can create your template in your favourite word processor, and just include the merge fields such as the recipient name, company and message text by inserting a field where you wish to have the actual names/information inserted. For example, to have a field recipient name filled in, include a text <R_Last> in the coverpage template.

For example a very simple coverpage with recipient name and company could be created as follows;

Recipient Name: <R_Last>

Company: <R_Company>

Note; the name field is not called name because it corresponds with the Exchange phone book.

Supposing you want to send a fax to Pete Johnson at York computers, the fax would be sent out as follows;

Recipient Name: Pete Johnson

Company: York computers.

The merge fields in the RTF file are replaced by the Exchange phone book entries and then the coverpage is converted to fax format.

The easiest way to design a cover page is to adjust one of the samples included with FAXmaker in the coverpage directory. To do this simply open up one of the coverpages in your word processor, for example Wordpad, and move around, add or delete merge-fields and/or text as you wish.

After you have finished designing your cover page, save the template as an RTF file and assign it to a user using either the Exchange administrator� XE "Exchange administrator" �� XE "administrator" � or the Remote administration� XE "Remote administration" � option. If you wish to make this the default coverpage for the entire company, copy it to the Faxmaker\coverpge directory and call it defcover.rtf or deftempl.rtf, whichever applicable.

For more information on remote administration, see the corresponding chapter.

TIP; Use Wordpad or MS Word to design your coverpages/templates. FAXmaker uses conversion technology used by these applications also, and therefore it will give you “what you see is what you get” 

TIP; use the rtf2fax.exe program located in the FAXmaker directory to preview� XE "Preview" � your template/coverpage as a fax file. 

Supported merge-fields;

The following merge-fields may be used in the RTF file.

Sender fields; 

These fields are replaced by the sender information.



Address Fields�Merge code��Initials�<S_Initials>��Last�<S_Last>��Company�<S_Company>��Display	�<S_Display>	��Address�<S_Address>��City�<S_City>��State�<S_State>��ZipCode�<S_ZipCode>��Country�<S_Country>��Title�<S_Title>��Department�<S_Department>��Office�<S_Office>��Assistant�<S_Assistant>��Phone�<S_Phone>��Phone Fields�Merge code��Business�<S_PH_Business>��Business2�<S_PH_Business2>��Fax�<S_PH_Fax>��Assistant�<S_PH_Assistant>��Home�<S_PH_Home>��Home2�<S_PH_Home2>��Mobile�<S_PH_Mobile>��Pager�<S_PH_Pager>��Business�<S_PH_Business>��Business2�<S_PH_Business2>��Fax�<S_PH_Fax>��Assistant�<S_PH_Assistant>��Home�<S_PH_Home>��Home2�<S_PH_Home2>��Mobile�<S_PH_Mobile>��Pager�<S_PH_Pager>��Recipient fields

These fields are replaced by the recipient information.



Addres Fields�Merge code��Initials�<R_Initials>��Last�<R_Last>��Company�<R_Company>��Name	�<R_Display>��FAX number�<R_Address>��City�<R_City>��State�<R_State>��ZipCode�<R_ZipCode>��Country�<R_Country>��Title�<R_Title>��Department�<R_Department>��Office�<R_Office>��Assistant�<R_Assistant>��Phone�<R_Phone>��Phone Fields�Merge code��Business�<R_PH_Business>��Business2�<R_PH_Business2>��Fax�<R_PH_Fax>��Assistant�<R_PH_Assistant>��Home�<R_PH_Home>��Home2�<R_PH_Home2>��Mobile�<R_PH_Mobile>��Pager�<R_PH_Pager>��Business�<R_PH_Business>��Business2�<R_PH_Business2>��Fax�<R_PH_Fax>��Assistant�<R_PH_Assistant>��Home�<R_PH_Home>��Home2�<R_PH_Home2>��Mobile�<R_PH_Mobile>��Pager�<R_PH_Pager>��General fields

Message text:		<message>

This field inserts the text of the coverpage as entered in the message dialog of Exchange. Be sure to leave enough space in the RTF file.

Current time:		<time>

Current date:		<date>

These fields insert the date and time of the fax. Please note that the date and time of the server machine will be used.

Subject:		<subject>

This field inserts the subject line of the message

Tips on designing a cover page

When designing your cover page in RTF format, please take note of the following;

a. To preview your cover page as a fax, use the rtf2fax program located in the FAXmaker directory

b. Remember that RTF does not support tables and headers/footers

c. Remember that merge fields are replace by the actual field values. Therefore, if you do not leave sufficient space, long names can mix up your formatting.

�Sending Faxes with FAXmaker

Benefits of sending faxes with FAXmaker



Using FAXmaker is also environmentally friendly, because you save on paper and toner ink.� \definition "FAXmaker" ��FAXmaker allows you to send and receive faxes from your PC, without having to print the document first, walk to the fax machine, key in the fax number and reschedule at a later stage if the number is busy.

Instead, FAXmaker uses a FAX server computer, located on your network, which is assigned all Fax related jobs, and also allows you to send and receive faxes at the same time!��The benefits

You no longer need to print out a document prior to faxing it.

FAXmaker will automatically retry fax numbers if they are busy.

Your faxes are more legible and of a better quality, since they are sent directly from your PC, using high resolution techniques.

Incoming faxes can be automatically routed to you as soon as they are received.

Only you can view your outgoing and incoming faxes.

You can easily send faxes to groups� XE "Groups" � of people. 

Ways to send a fax

There are several ways to send a fax with FAXmaker:

1.  Create or open a document in any Windows application and print it with the FAXmaker printer driver. This automatically activates the Exchange Message Send window from which you can send the fax.

OR;

2.  Start Exchange to send any text you can type in the Exchange editor.

Sending a Fax from an Application

Sending a fax from a Windows application is a simple process in which you make a document in your word processor or any Windows application, and then fax it using FAXmaker's printer driver. If you can print the document in Windows, you will be able to fax it with FAXmaker. Follow the steps outlined in this section to fax your registration form to GFI FAX & VOICE:

1.  Start Write/Wordpad.

2.  Enter some text or open and existing document.

3.  Choose the FAXmaker printer driver as your current printer. The FAXmaker printer driver is a mechanism which stores your document as a fax file. 

a.  From Write's 'File' menu, choose 'Printer Setup'. Select the FAXmaker printer driver and choose 'OK'.

�

Selected FAXmaker printer driver

4.   Print your letter.

a.  From Wordpad/Write's 'File' menu, choose 'Print'. In the 'Print' dialog box, click on 'OK'. 

b.  Immediately after the printer driver has printed your document, The Exchange client starts with the 'Message Send Dialog'. 

5.  Click on the 'To' field to start the Exchange address book.

�

Exchange send message dialog with FAXmaker attachment

6.  Click ‘New; to create a new address. Select FAXmaker address. A dialog will pop up� XE "Pop up" � for a name and a fax number. Enter GFI FAX & VOICE and the fax number; 00,356-661072.

�

Creating a new FAXmaker address

7.  You can attach FAXmaker fax files to your message using the attach file function.

Note; You can not attach any other file except for FAXmaker fax files.

8.  Click on the 'Send' button, when you are ready. The fax will be sent by FAXmaker, and it will notify you on the status of the fax.

Specifying additional recipients for the fax

One can specify multiple recipients using Exchange, but a list of additional recipients can also be added using an extra options line in the body of the message. 

To add an additional recipient, simply type a double colon followed by name (optional), company (optional) and number. For example;

::Registration, GFI FAX & VOICE, 00,356661072

One can add a whole series of recipients in this manner.

� XE "FAX options" \r "D2HBFAX_options36" �FAX Options

When sending a fax you can enter send options such as high or normal resolution, schedule time, cover page� XE "cover page" \r "D2HBcover_page36" � to be used etc., at the top of the mail, preceded by a double colon.

You only need to specify fax options in this way, if the defaults which you or your administrator� XE "administrator" � have set, need to be overridden. For more information on this, see remote administration.� XE "Remote administration" �

The following options can be used;

To specify a cover page

C=<cover page name>

Where <cover page name> stands for the name of your cover page. If you do not want to send a coverpage, but by default a coverpage is added, you can override this option temporarily by specifying “none” instead of a cover page name. This will cause FAXmaker not to add a coverpage. Remember that the cover page must be stored on the server first.

To specify high or low resolution

'H' or 'N'

Where H stands for high resolution (200 * 200 dpi) and N for normal resolution (200 * 100 dpi).

To specify a template

T=<template name>

Where <template name> stands for the name of the template. Remember that the template must be stored on the server first.

To schedule a fax

nn::mm 

Where nn equals hours and mm equals minutes

To specify a billing code� XE "Billing code" �

Bnnnn

Where nnn can be replaced by any number. This number will be added in the log file and can then be used to apportion costs.

To attach a file to your fax

A=<name>

Where <name> stands for the name of a fax attachment.� XE "Fax Attachment" \r "D2HBFax_Attachme36" � Remember that the fax must be stored previously on the server. Multiple attachments� XE "attachments" \r "D2HBattachments36" � can be added to the fax.

Multiple options

When you are using multiple options in a message, you must put them on the same line, separated by a comma.

For example;

:: c = cover , t=templ, a=attach, h, 23:01

This example sends a fax with “cover” as a cover page, formatted in “templ” with the attachment “attach”. Furthermore, the fax is sent in high resolution and scheduled to be sent at 23.01 hours.

Note; Remember that prior to using fax options, you must ensure that you have actually stored the attachments, templates and coverpages that you are using.

Creating a Fax Attachment

Attachments can be handy to store frequently faxed information such as product brochures. These can be graphics intensive, so it makes sense to convert them only once to fax format and store them as fax attachments. To create a fax attachment;

1.  Start the application in which the document is saved.

a.  From that application's menu, choose 'Print Setup'

b.  Select the FAXmaker printer driver and click OK. The Exchange message dialog will pop up.� XE "Pop up" �

c. Double-click on the attachment. The viewer will convert and load the fax.

d. To save the fax as an attachment, simply use the save as function in the viewer.

e. You can either choose to send this attachment immediately, or cancel the send fax process and return to the application.

Receiving a Fax

Incoming faxes are logged in your mailbox.� XE "Mailbox" � The message will ready “FAX from”, followed by the FAX ID� XE "Fax ID" � (CSID� XE "CSID" �). To view the fax, double-click on the message, and then double-click on the attachment. The FAXmaker viewer will load and display your fax.



�� XE "Remote administration" �Remote administration

Introduction

Each user has a set of options or defaults which specify how a fax must be sent by FAXmaker. These options include which coverpage to use, template, fax attachments� XE "attachments" \r "D2HBattachments39" � if any, and even the resolution at which the fax must be sent.

These options can be set from the Exchange administrator.� XE "Exchange administrator" �� XE "administrator" � However, in order to reduce the administration burden, these options can also be set by the user themselves. This is can be done by sending message to the faxadmin, and is called “Remote administration”

FAX admin

Remote administration is done by sending messages to the ‘Fax administrator’. The Fax administrator is simply FAXmaker address, which, instead of a number has “faxadmin”  as the fax number. This way the FAXmaker server will know that this message concerns ad administration option.

�

Creating a Faxadmin address in Exchange phone book

Coverpage administration options

FAXmaker allows users to add multiple coverpages which can be used interchangeably, and to set a particular coverpage as default.

Before a coverpage can be used, the coverpage file (RTF format) must be stored on the server and it must be given a name.

To store a coverpage:

Send To:	FAXADMIN

Subject:	C=<coverpage name>{ ,default }{ ,delete }

Insert coverpage as attachment

Do not add multiple attachments. To insert an attachment in Exchange, use the Insert file command from the message menu.

If you wish this cover page� XE "cover page" � to be the default coverpage, add “, default” in the subject line.

If you wish to delete this coverpage file and name, add “, delete” in the subject line and do not attach a file.

Template administration options

FAXmaker allows users to add multiple templates which can be used interchangeably, and to set a particular template as default.

Before a template can be used, the template file (RTF format) must be stored on the server and it must be given a name.

To store a template:

Send To:	FAXADMIN

Subject:	T=<template name>{ ,default }{ ,delete }

Insert template as attachment

Do not add multiple attachments. To insert an attachment in Exchange, use the Insert file command from the message menu.

If you wish this template to be the default template, add “, default” in the subject line.

If you wish to delete this template file and name, add “, delete” in the subject line and do not attach a file.

Attachment administration options

FAXmaker allows users to store attachments, for example a price list or product brochure. This has the advantage, that you do not need to resent the physical file each time you want to attach it to your fax.

Before an attachment can be used, the attachment ( in FAXmaker fax format) must be stored on the server and it must be given a name.

To store a fax attachment:� XE "Fax Attachment" �

Send To:	FAXADMIN

Subject:	A=<attachment name>{ ,delete }

Insert attachment as attachment

Do not add multiple attachments.  To insert an attachment in Exchange, use the Insert file command from the message menu.

If you wish to delete this attachment file and name, add “, delete” in the subject line and do not attach a file.

Setting the default fax resolution

Each user can specify the default resolution with which a fax must be sent. A fax can be sent at high resolution, which results in a sharper looking fax but also in longer transmission times, or in normal resolution, which cuts transmission time roughly in half.

To change the default resolution setting;

TO:		FAXADMIN

Subject:	defaults

In the Message-body:

Resolution = High or Normal



� XE "FAX header" \r "D2HBFAX_header41" �Setting the FAX header

Each user can specify a personal fax header, to be displayed on top of each fax he/she sends. 

To enter a personal fax header;

Send To:	FAXADMIN

Subject:	defaults

In the Message-body:

FAX header = <Faxheader>

Where fax header is the word or number to appear on top of the fax.

Setting multiple options at a time

You can specify multiple default  settings at one go, by adding several command lines. For example;

Send To:	FAXADMIN

Subject:	defaults

In the Message-body:

Coverpage = testcoverpage

Template = testtemplate

FAX header = GFI

Resolution = high

This will set testcoverpage as the default coverpage, testtemplate as the default template, GFI as the personal fax header and high as the default fax resolution.

Retrieving the defaults

To retrieve your personal default settings at any one time, simply send a message to faxadmin with defaults as the subject of the message.

To retrieve the defaults;

Send To:	FAXADMIN

Subject:	defaults

Leave the Message-body empty



�The Viewer

Introduction

With the FAXmaker Viewer, you can view, print and save fax files. The FAXmaker Viewer can be activated by double-clicking on a FAXmaker attachment in a message dialog. 

�Viewing Faxes

The viewer is used to:

1.  View incoming or outgoing faxes,  by double-clicking on the fax attachment� XE "Fax Attachment" � in the Message dialog of Exchange. The FAXmaker Viewer is automatically activated and displays the fax on screen.

2.  To preview� XE "Preview" � outgoing faxes, by double-clicking on the fax attachment in the Message dialog of Exchange. The FAXmaker Viewer is automatically activated and displays the fax as it will be sent.

In the Viewer itself you can:

a.  Preview pages one by one, using the 'Next' or 'Previous' command from the 'Page' menu. When your document is made up of one page, these functions will be dimmed.

b.  Re-size the document on your screen by choosing either the 'Horizontal Fit' or the 'Vertical Fit' from the 'View' menu.

c.  Zoom in or out whilst viewing the document from a number of viewpoints by choosing an appropriate zoom value from the 'View' menu. 

d.  Invert the image by choosing the Invert command from the 'View' menu.

e.  Print the document to your local printer by choosing the 'Print' command from the 'File' menu.

f . Save the fax on your hard disk. Choose the 'Save as' function from the 'File' menu (or click on the 'Save as' icon) and type the file name in the 'Save as' dialog. You can save documents in '*.fax', '*.tiff' or '*.dcx' file format. Choose 'Exit' from the 'File' menu.

�Troubleshooting

Server software problems

“The modem does not dial out.”

In some cases your modem may not dial out, returning the error message “No dial tone”. The problem could be caused by the fact that not all export� XE "Export" � modems recognise the dial tone. To solve this, disable “Wait for Dial Tone” in the Fax setup window of the server.

FAQ on http://www.gfifax.com  

An FAQ is a list of frequently asked questions (FAQ). GFI FAX & VOICE maintain a support FAQ, which lists answers to most common problems. If you have a problem with FAXmaker and access to the INTERNET, please access this FAQ first. 

The website URL is http://www.gfifax.com. The FAQ is located under the section product support.

The web site will always have the most up to date listing of support questions.
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